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Description

A linear static analysis is to
be carried out on the spanner
shown.

The spanner is supported as
though it were being used to
turn a nut, and is loaded with
a constant pressure load
along the top edge of the
handle.

Units used are N, mm, t, s, C, throughout.
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Linear Elastic Analysis of a Spanner

Objectives

The required output from the analysis is:

a
a
a

A plot of the deformed shape.
A plot of the equivalent stresses in the spanner.
A graph showing the variation in equivalent stress where the handle meets the

jaws.

Associated Files

Q

spanner_modelling.vbs carries out the modelling of the example.

Modelling : Features

This section covers the definition of the features (Points, Lines and Surfaces) which
together form the geometry of the spanner.

Q

a

The symmetry of the spanner will be used by firstly defining one half and then
mirroring about a horizontal centre-line.

One half of the jaws will be defined by three Surfaces using 3 different methods.
One Surface will be defined simply by its bounding coordinates, a second by
sweeping a Line through a rotational transformation and a third by copying the
second Surface using a pre-defined rotation.

One half of the handle will be defined using one Surface. It will be bounded by
three Lines, one of which will be a cubic spline.

Once the Surfaces have been defined, they will all be mirrored about the spanner
centre-line.

The features which make up the spanner will be divided into two Groups, the
jaws and the handle, to make the assignment of attributes easier.

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Introduction to LUSAS Worked Examples document.

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command
File>New to start a new model file. Modeller will prompt for any unsaved data and
display the New Model dialog.




Modelling : Features

Creating a new model

Enter a File name of
Spanner

Use the default User-
defined working
folder.

Ensure an Analysis
type of Structural is
set.

Select an  Analysis
Category of 2D
Inplane

Set Model
N,mm,t,s,C

units of

File name I spannet

—Working Falder
£ Recent I

% User-defined IC:'(Users'l,<username>\,Documents'l,Lusas 16.0\Projects Set,..

~Model properties

IStructuraI 'l Model units IN,mm,t,s,C 'l
Analysis category IZD Inplane 'I Timescale units ISacundS vl

Analysis bype

~Optional
Skartup template |2D Plane stress ‘l | Layout: grid INone 'I
Title I Spanner
Job number I
OK I Cancel Help

Leave the Timescale units as Seconds

Select a Startup template of 2D Plane Stress.

Ensure the Layout grid is set as None

Enter a Title of spanner

Click the OK button.

The Attributes &% treeview will be populated with potentially useful basic line mesh,
geometric and support entries appropriate to the settings made on the new model dialog.

K7 .
Note. The Undo button ﬂ may be used to correct a mistake. The undo button
allows any number of actions since the last save to be undone.

Modelling geometry

LUSAS Modeller is a feature-based modelling system. The model geometry is defined
in terms of features (Points, Lines, Surfaces and VVolumes) which are later meshed to
generate the Finite Element Model ready for solution. The features form a hierarchy,
with Points defining Lines, Lines defining Surfaces and Surfaces defining Volumes.




| Geometry

Surface >
By Coords...

Linear Elastic Analysis of a Spanner

EI Enter coordinates of (0, 20), (-20, 20), I
(-20, 30) and (0, 40) to define the vertices [ arid style
of the Surface. ™" 3 columns
Note. Sets of coordinates are separated by 3 D;z‘g Za!
commas or spaces. The Tab key is used to 2 30,30
create new entry fields. The arrow keys are 3 -20.30
used to move between entries. 4 0.40 3
e Click the OK button to make the
dialog disappear and generate the
Surface as shown.
i Local coordinate
Note. If the Z ordinate is omitted zero is | Glabal coordinates =l
assumed. _ _
" | St a5 active local coordinate

Note. Confirmation that the Surface has
been created is given in the message oK I
window.

Cancel | Help |

Note. Cartesian, cylindrical or spherical coordinates systems may be used to define
models. In this example Cartesian coordinates will be used throughout.

The right-hand vertical Line will be used to create a Surface by sweeping the line
through a rotation of 45 degrees clockwise.

o Select the Line by selectthisLine
moving the cursor over

the Line shown and
clicking the left-hand
mouse button.

The line will change colour to
show it has been selected.

Note. Feedback on the items
currently selected is provided on
the right-hand side of the status

bar at the bottom of the display.
i&e» A

... and sweep it to
form this SurfaceY




Modelling : Features

| Geometry

Surface S él Select the Rotate option gnd
By Sweeping.. enter -45 for the angle of rotation

about the Z-axis.

Enter the attribute name as
Rotate 45 Clockwise

Click the Save button to save
the dataset for re-use later.

Click the OK button to sweep
the Line clockwise through 45
degrees about (0,0,0) to create
a Surface.

Note. Clockwise angles are
/ negative and anti-clockwise angles

are positive.

The Surface just drawn will now be
copied by rotating it through a 45
degree rotation clockwise.

Select the  previously
drawn Surface by clicking
on it with the left-hand
mouse button.

£ Tramslate % Robate = Mirrar " Scale
—Angle —About axis ——Crigin of axis
e # ¥ Zz
|-45.n e [00 [0.0 [0.0
 y-axis
(+ve angles O T
anti-clockwise i
about the axis) | T Specified

I~ Sweep type
' Minorarc " Major arc  straight

—Order of geometry ko create
" Line % Surface = Solid|of reyolution

r~ Transformations generated from memory selection

INo transfarmations generated j e |
Name IRotate 45 Clockwise vl ﬂ (1)

Help

Select and copy
this Surface

To form this §urface

Lo




| Geometry

Surface >
Copy...

| Geometry
Line >

By Coords...

Linear Elastic Analysis of a Spanner

i . Copy
M Select the attribute Rotate 45
Clockwise from the drop down list. S Transles ) Rois ) b ) fliesr
) 5edle £ Compound
e Ensure that the number of —Angle ~About axis —~ Originof axis————————
. . % W z
copiesissetto 1 e O teais [0 o0 [os
1 y-axis

e Click the OK button to copy veandes | & 7 g
anti-clockwise

the Surface, rotating it about the axis) | Specified
clockwise through 45 degrees.
Nurber of copies |1 ill

r—Transformations generated From memory seleckion

Mo transformations generated j Ilse |

Hame IRotate 45 Clackwise vl ﬂ (13
ok I Cancel | Save | Help |

To define the top line of the handle of the spanner a cubic spline will be created.

Note. A cubic spline is a Line which passes through any number of Points. If required,
the start and finish directions of the spline can be defined by specifying end-tangents
(i.e. by specifying the directions of Lines at its ends).

In this example end-tangents are used to fix the start and finish directions of the spline
so0 a construction Line must first be defined.

il .
Enter coordinates of (200, 0) and (200, -10)
to define the construction Line. (G"d A= |
e Click the OK button to generate a vertical ®.Y.Z)
Line away from the existing Surfaces. L s a3

This Line will be used to specify the finishing
direction of the cubic spline.

Note. When selecting features to define a cubic
spline it is very important that the correct features
are selected in a particular order. The Lines that
define the start and finish directions of the spline
are to be selected first, followed by the Points that
define the start and end positions of the spline. [ o | cancel | hep |

~Local coordinate
IGIobaI coordinates j

™| 5et a5 active local coardinats




Modelling : Features

Defining a cubic spline

| Geometry .

| Line >

E

\

pline
Tangent to

Lines...

Select the arc shown 1. Select thisarc
by moving the mouse

over the arc and click @ 3. Select this Point
the left-hand mouse &

button.  (This arc
defines the direction

4. Select this Poinl.:>
2. Select this Line@

in which the spline

starts).

Select the construction Line defined earlier by moving the mouse over the Line
shown and click the left-hand mouse button. (This Line defines the direction in
which the spline ends).

Hold the Shift key
down to add additional features to the selection

Continue holding the Shift key down to further add to the selection. Select the
Point on the end of the first arc selected. (This defines where the spline starts).

Still holding the Shift key down, select the Point on the end of the construction
Line. (This defines where the spline ends).

Click the OK button to generate a default cubic spline to form the handle of the
spanner, ensuring that both reverse options are off.

Note. Line directions can be seen by double-clicking on the Geometry entry in the
/ Treeview and selecting the Line directions check box.

Once the spline is drawn correctly the construction Line is deleted.

Drag a box
around the
construction Line
by firstly moving
the mouse above
and to the left of

3

|
the Li - Jk

e Line. . .
Drag a box around the construction Lin

Click the left-
hand mouse button and holding it down move the mouse to the right and down
so that a box is shown which completely encloses the Line as shown. Release the
left-hand mouse button. LUSAS will highlight the selected features.




| Edit
Delete
| Geometry
Line >
| By Points...
| Geometry
| Surface >

Linear Elastic Analysis of a Spanner

E Delete the selected features.
e Click the Yes To All button to delete the selected Line and Points

Note. The Delete key can also be used to delete features. For a full list of keyboard
shortcuts refer to the Online Help file, which can be accessed from the Help > Help
Topics menu.

The centre-line of the spanner can now be defined by joining the two unconnected
points into a Line.

e Drag a box
around the two
Points on the
centre-line of the ]
spanner as shown L

J
Drag a box around these 2 Point

il A Line will be drawn between the points selected.

The Surface forming the handle of the spanner will now be defined by selecting the
three Lines bounding the Surface.

e Select the 3 Lines
which define the

1. Select thisLine
2. Hold Shift key down

T L)
3. With Shift keM i&

down select thisLine

Surface of the
handle in the order
shown,  ensuring

the Shift key is
held down to keep
adding to the
selection.

4. With Shift key
down select this Line

_I If prompted, press OK to draw the Surface formed by the 3 lines selected.

Note. Selecting the Lines in this anti-clockwise order ensures that the local element
axes of the Surface will be suitable for the applied face loading that will be applied later
in the example. Selecting the Lines by dragging a box around them would not
necessarily produce the same Surface axes.

Mirroring model information

Half of the model has now been defined. This half can now be mirrored to create the
whole model. The first step in the process is to define a mirror plane.




| Edit

Selection Memory >

Set

| Geometry

Surface >
Copy...

| Edit

Selection Memory >
Clear

Modelling : Features

e Select the 2 points
shown, making sure
the Shift key is held
down in order to add
the second Point to
the initial selection.

1. Select this Point
2. Hold the Shift key down

These Points define the axis
about which the spanner
will be mirrored.

3. Select this Point

Places the Points selected into memory.

Next, the Surfaces to be mirrored are to be selected. This will require the whole model
to be selected.

e Select the whole model by dragging a box around the features

Note. An alternative to dragging a box around all the features to select them is to
press the Ctrl and A keys at the same time.

- _ _ o

M Select Mirror — from Point 14

and Point 15 from the drop down list = £ Translte (" Rotate Mo Miror
 Seale " Compound

and click the Use button on the
- . - Mirrar poinks
dialog to use the points previously - " 2

stored in memory. ¢ General [40.0 [7.0s¢ o0
% parallel to Z axis
. . 200.0 0.0 0.0
e Click the OK button to copy C pusleltovaxs || ! !
1 Parallel to ¥ axis I 40,0 I 7. 10543E- I 10

all of the Surfaces, mirroring
them about the centre-line to =

. . i | 1 -
give the model shown in the Hmber oF copies ~
previous dlag ram  Transformations generated Fram memory selection

IMirror - from Point 14 and Paint 15 j

If the model features have been
mirrored successfully the Points held
in memory may be cleared.

Mame I vl ﬂ (new)

The Points are now cleared from o |
memory.

Cancel I Save I Help |

Note. Right-clicking on the view with geometry selected opens a menu with shortcuts
to Delete, Move, Copy and Sweep.

This has completed the spanner geometry.




Linear Elastic Analysis of a Spanner

Using Groups

Tip. Model features can be grouped together to make assignment and viewing of
model attributes easier.

In this example the Surfaces defining the jaws of the spanner will form one Group. The
Surfaces defining the handle of the spanner will form another Group.

e Dragaboxaround £~ "7777 1
the Surfaces
representing the
jaws of the spanner.

G .
| Geometry S This adds a New

| Group

“[NewGroup  Group entry to the
Treeview for the features L | Drag a box to select
selected. @~ —mm——=-- kthe Jaw features

e Enter the group name as Jaws and click OK to finish defining the group.

e Drag a box F—————————————————— 1
around the I
Surfaces

representing the I
handle of the l
spanner. :

Geomet .
| ﬁ;’{gjpry S This adds a New |L |
|New Group Group entry to thel e ~~ — 77—/ — T T T k
Treeview for the Drag a box to select the Handle feature

features selected.

e Enter the group name as Handle and click OK to finish defining the group.
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Modelling : Attributes

Modelling features recap

The features that form the 2-Dimensional representation of the spanner have been
defined. In this section the following topics have been covered:

a
a

(W]

(I W W Wy Wy

How to define Points, Lines and Surfaces.

How to define Lines by specifying the coordinates of their Points and by joining
existing Points.

How to define Surfaces by their bounding coordinates, by sweeping, and by
copying.

How to define a cubic spline.

How to select features by using the Shift Key to add to a previous selection.
How to select features by dragging a box around features to be selected.

How to select all features in a model by pressing the Control and A keys.

How to rotate and mirror model features.

How to define groups of features.

Modelling : Attributes

The Attributes % treeview will be initially populated with useful basic line mesh,
geometric and support entries appropriate to the settings made on the new model dialog.
Where applicable these can be assigned directly to selected features in a model, or be
edited as required. Otherwise, specific attributes will need to be defined.

For this example the following attributes need to be defined:

U The finite element mesh to be used.

U The thickness of the spanner.

U The material from which the spanner is made.
U The supports to be used.

U The loading on the spanner.

11



Linear Elastic Analysis of a Spanner

Defining and assigning model attributes
Layers Grou... &Attri... l@AnaI... ;;?""Utilit... Repo...

= a spanner, mdl
=42 Attributes

Note. LUSAS Modeller works on a
define and assign basis where
attributes are first defined, then
assigned to features of the model.
This can be done either in a step-by-
step fashion for each attribute or by
defining all attributes first and then
assigning all, in turn, to the model.

O Attributes are first defined and
are subsequently displayed in
the 63; Treeview as shown.
Unassigned attributes appear
‘greyed-out’. Assigned
attributes appear 'coloured'.

O Attributes are then assigned to
features by dragging an
attribute dataset from the
Treeview onto  previously
selected features.

Tip. Useful commands relating to
the manipulation of attributes can be
accessed by selecting an attribute in
the & Treeview, then clicking the
right-hand mouse button to display a
shortcut menu.

Defining the mesh

Ea Mesh
Ela Line
----- 1:Thick beam, linear order, div =1
----- 2:Thick beam, linear order, div =4
----- 3:Thick beam, linear order, element length = 1
----- 4:Bar, linear order, div =1
----- S:Ear, linear order, div =4
----- 6:Bar, linear order, element length = 1
----- Zihull, div =1
----- S:hull, div =2
----- :ull, div =3
----- 1Ml div =4
----- 11:Mull, div==5
----- 12:mhull, div = 12
----- 13 Mull, element length = 1
=423 Surface
e 14:Flane stress
[—:I--a Geomekric
Ea Surface
o 1:Unit Thickness
[—]--ﬁ Material
E153 Isatrapic
----- 1:5teel (Mild Steel Steel - Structural)
[ Z:Zonerete {Ungraded Concrete)
=53 suppotts
L 1eFimed in ¥y
Z:Fully Fixed
F5ymmetry parallel to ¥ (fixed ¥ and ThZ)
4:5ymmetry parallel to ¥ (fixed ¥ and ThZ)
S:Fixedin ¥
it BFixed in Y
=23 Loading
Ea Structural
[ 1:BFP1 (Gravity -ve 1)

The spanner will be meshed using both regular and irregular Surface meshes. A regular
mesh is to be used for the jaws of the spanner. An irregular mesh will be used for the
handle.

The number of elements in the regular Surface mesh will be controlled by defining line
meshes on the Lines defining the boundary of the Surfaces. The number of elements in
the irregular Surface mesh will be controlled by specifying an ideal element size. Other
methods of controlling mesh density are also available.

12



| Attributes

Modelling : Attributes

[Mesh
|Surface...

| File

Defining a regular surface mesh

e Select Plane stress EhigEdal=y

elements, which are
Quadrilateral in
shape with a
Quadratic
interpolation order.

e Ensure that the

Regular Mesh
button is selected
and Allow

transition pattern
is not selected.

Analysis category

I 2D Inplane

Skructural |

% Element description
Element type
IPIane stress j
Element shape
IQuadriIateraI j
Interpolation arder
IQuadratic j
" Element name
| CPMBE

" Regular mesh
[~ allowe transition pattern
= | allovirregular mesh
v automatic

™| Elemnent size I 1.0
Local x divisions I 4
Local v divisions I 4

" Trregular mesh

™| Elerment size I 1.

| Model Properties...

e Enter the attribute

name as Regular

Plane Stress Mame IReguIar Plane Stress j ﬂ {new)
e Click the OK button

to add the Surface I e e

mesh dataset to the
& Treeview.

The mesh will be assigned to the model at a later stage.

Controlling mesh density

The lines currently defined have 4 divisions per line by default, but in this example only
2 divisions are required for the Lines defining the jaws. This can be done by either
changing the default number of divisions per Line or by making use of Line mesh
attributes. In this example, the default number of divisions will be changed.

e Select the Meshing tab and set the Default Line divisions to 2.

e Click the OK button.

13



| Attributes

Linear Elastic Analysis of a Spanner

|Mesh
|Surface...

| Attributes

| Geometric
|Surface...

Defining an irregular surface mesh

Select Plane stress,
Triangle, Quadratic
elements.

Select the Irregular
mesh button.

Select Element Size
and then specify an
element size of 18.
(This  defines the
maximum side length
of the elements on the
lines defining the
perimeter of the
spanner.)

Enter the attribute
name as lrregular
Plane Stress.

Analysis category

I 2D Inplane

Struckural |

Surface Mesh [ %]

' Element description

Element type

IPIane stress j
Element shape

ITriangIe j
Interpolation order

IQuadratic j

7 Element name

" Regular mesh
¥ | &llovs bransition pattern
¥ allovirregular mesh
¥ | sutamatic

™| Elemment: size: I 1.0
Lacal x divisians I 2
Local v divisions I 2

I TRME

& Trregular mesh

¥ Element size I 18

Marme I Irregular Plane Stress

j ﬂ {rmew)

OF I Cancel | Apply | Help |

Click the OK button to add the Surface mesh attribute to the &Treeview.

The mesh will be assigned to the model at a later stage.

Defining the thickness

So far the spanner has been defined in two dimensions. In order to give the spanner its
thickness geometry attributes will be used. The jaws of the spanner are 15mm thick
whilst the handle is 10mm thick. Two geometry attributes are required.

Enter the
thickness as 15.
Yalue
Enter the Thickness |t 15
E ccentricity | ez

Attribute name as
Thickness=15

Click the Apply
button to add the
geometry attribute
to the
Treeview.

Marne | Thickness = 15

j ﬂ (new)

oK I Cancel |

Apply | Help |

14




Modelling : Attributes

Note. The Apply button allows information for another attribute to be entered using
the same dialog.

e Change the thickness to 10

e Change the attribute name to Thickness=10 and click the OK button to add the
additional geometry attribute to the & Treeview.

Assigning a surface mesh and thickness to the jaws

The Surface mesh and geometry attributes defined previously can now be assigned to
the relevant features of the spanner. As an alternative to selecting features by dragging a
box around them, the previously named Groups can be used.

e In the L=l Treeview, click the right-hand mouse button on the group name Jaws
and select the Select Members option from the menu. If you already have some
features selected click Yes to deselect them first.

e Drag and drop the Surface
mesh attribute  Regular ﬁ
Plane Stress from the &
Treeview onto the selected =+
Surfaces. Modeller  will
confirm the mesh

assignment for each Surface
in the text window.

The element mesh for the jaws of the spanner will be drawn.

e Drag and drop the Surface geometry attribute Thickness=15 from the &
Treeview onto the selected Surfaces. The elements of the jaws remain selected.

o Click the left-hand mouse button in a blank part of the View Window to deselect
any previously selected model features. This shows that the geometric
assignment has been visualised by default.

Assigning surface mesh and thickness to the handle

e In the Treeview, click the right-hand mouse button on the Group name
Handle and select the Select Members option from the menu.

All Surfaces forming the group Handle will be selected.

15



Linear Elastic Analysis of a Spanner

o Drag and drop the Surface mesh attribute Irregular Plane Stress from the &
Treeview onto the selected Surfaces defining the Handle.

LUSAS will draw the
irregular element mesh for
the handle of the spanner.

Note. The text output
window will show messages
relating to the radius of
curvature for two of the
elements created. These can
be ignored for this example.

e Drag and drop the Surface geometry attribute Thickness=10 from the &
Treeview onto the selected Surfaces. Again confirmation of the assignment is
provided in the text window.

e Click the left-hand mouse button in a blank part of the View Window to deselect
any previously selected model features.

Assigning the material

The material required for this example is provided by default when using the startup
templates specified when creating the model.

e Right-hand click the material attribute Steel (Mild Steel | Steel - Structural)

from the &b Treeview and select Assign to all to apply the mild steel attribute to
the whole model.

Visualising model attributes

Note. Any attributes (i.e. geometry, material, supports etc.) assigned to the model can
be checked visually to ensure that the correct item has been assigned to the correct part
of the model. For example:

o Click the left-hand mouse button in a blank part of the View Window to deselect
any previously selected model features.

o Inthe &b Treeview, click the right-hand mouse button on the Thickness=15
material attribute name and select the Visualise Assignments option from the
dialog.

16



Modelling : Attributes

All features to which the
Thickness=15 attribute is
assigned will be visualised.

e To turn-off the
visualisation of the
assignments, click the
right-hand mouse
button on the

Thickness=15 material attribute name in the & Treeview and select the
Visualise Assignments option again from the dialog.

Note. This method can be used at any time during this example to check that selected
attributes have been correctly assigned to the model.

Manipulating layers

At any time the layers displayed in the Treeview may be re-ordered, hidden,

removed or be re-added.

e Select the Mesh entry in the Treeview and drag it down to sit beneath the
Geometry entry. In the view window the mesh can now be seen drawn on top of

the geometry.

e Click the right-hand mouse button on the Mesh entry in the Treeview and
select the On/Off option. The mesh will be hidden from the display.

Fleshing

Visualisation of assigned geometric attributes can also be seen using the fleshing

option.

!l Select the fleshing

on/off button to turn-on
geometric property
visualisation.

El Select the isometric

button to see the geometric
visualisation on the elements.

El Select the dynamic

rotate button to view the
spanner from the side. The

17



Linear Elastic Analysis of a Spanner

difference in thickness between the handle and the jaws can be seen.

ll Select the fleshing on/off button to turn-off the geometric visualisation.

@l Select the Home button to return the model to the default view.

il Reset to normal cursor mode.

Supports

When using one of the standard startup templates, LUSAS provides the more common
types of support by default. These can be seen in the &b Treeview. Two support
attributes are required, one which restrains movement in the X direction, and one which
restrains movement in the Y direction.

Assigning the supports

Select the Pointon the  Select these 2 Points for support 'Fixed in Y"
centreline  of  the

spanner as shown to

assign the support

Fixed in X.

Drag and drop the
support attribute
Fixed in X from the
&Treeview onto the Select this Point for support
selected point. 'Fixed in X'

Click the OK button to assign the support to the Point selected for all the
loadcases in analysis 1.

The support will be visualised using an arrow symbol.

Select the 2 Points shown to assign the support Fixed in Y. Hold the Shift key
down to add the second point to the initial selection.

Drag and drop the support attribute Fixed in Y onto the selected points.
Click the OK button to assign the support to the points selected.
The supports will be visualised using arrow symbols.

Click the left-hand mouse button in a blank part of the view window to deselect
any previously selected model features.

18



| Attributes e Select the Face option and click Next
Loading... >
r Structural

Modelling : Attributes

Defining the loading

A pressure load is to be distributed evenly along the top edge of the handle.

" Concentrated

" Body Force

" Global Distributed
% Face

" Local Distributed
" Temperature

™ Temperature profile

" Prescribed Displacement
" prescribed Velodty
™ Prescribed Acceleration

£ Initial Velocity

r~Discrete
™ Sirain profile ™ Paoint
" Stress and Strain " patch
" Internal Beam Point " Compound
" Internal Beam Distributed
" Tendon
= Back | Mext = | Firish | Cancel | appli | Help |

e On the Face loading dialog enter a load of 0.1 in the y direction.
e Enter the attribute name as Face Load of 0.1.

o Click the Finish button to add the loading attribute to the FoTreeview.

19



Linear Elastic Analysis of a Spanner

Assigning the loading

e Select the Line on Select thisLine
the top edge of the
spanner handle. J

e Drag and drop the

loading attribute
Face Load of 0.1
from the
Treeview onto the
selected Line.

e Click the OK
button to assign
the loading to the
Line selected.

Note. If the loading is displayed in the opposite direction to that shown the Surface
/ forming the top half of the handle may be reversed as follows:

e Select the Surface defining the top-half of the spanner by dragging a box around

It.
| Geometry This will reverse the Surface axes and hence the direction of the loading.
Suface >
|Reverse...
Saving the model
Fil )
| ]Zave El To save the model file.

Modelling attributes recap

In this section, the attributes of the model were defined and assigned to the features.

O A regular Surface mesh with quadrilateral plane stress elements was defined and
assigned to the jaws of the spanner. An irregular Surface mesh with triangular

20



Running the Analysis

plane stress elements and a fixed element size was defined and assigned to the
handle of the spanner.

O Two geometry attributes were used to specify the spanner jaws and handle
thickness.

O A material attribute specifying the properties of steel was assigned to all
Surfaces.

O Two support attributes were assigned in order to simulate the spanner being used
to turn a nut and a structural face load was applied to the top edge of the handle.

O Attributes assigned to the model were checked visually for correct assignment.

The model definition is now complete. The next step in the process is to run an analysis
to solve the problem.

Running the Analysis

A

El Open the Solve Now dialog and press OK to run the analysis.

If the analysis is successful...
Analysis loadcase results are added to the (B Treeview.

In addition, 2 files will be created in the Associated Model Data directory where the
model file resides:

U spanner.out this output file contains details of model data, assigned
attributes and selected statistics of the analysis.

U spanner.mys this is the LUSAS results file which is loaded automatically
into the ‘X! Treeview to allow results processing to take place.

If the analysis fails...

If the analysis fails, information relating to the nature of the error encountered can be
written to an output file in addition to the text output window. Any errors listed in the
text output window should be corrected in LUSAS Modeller before saving the model
and re-running the analysis. Note that a common mistake made when using LUSAS
Modeller for the first time is to forget to assign particular attribute data (geometry,
mesh, supports, loading etc.) to the model.
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[New...

| File

| Script

| Run Script...

Rebuilding a Model

If errors are listed that for some reason cannot be corrected, a file is provided to re-
create the model information correctly, allowing a subsequent analysis to be run
successfully.

O spanner_modelling.vbs carries out the modelling of the example.

gl Start a new model file. If an existing model is open, Modeller will prompt for
unsaved data to be saved before opening the new file.

e Enter the file name as spanner

To recreate the model, select the file spanner_modelling.vbs located in the \<LUSAS
Installation Folder>\Examples\Modeller directory.

El Solve the model to generate the results.

Viewing the Results

In this section the results produced by the analysis of the spanner will be viewed. There
are a number of ways to do this in LUSAS, allowing you to choose the most appropriate
way to present your results. For this example:

O A plot of the deformed mesh will be displayed and superimposed upon the
undeformed shape for comparison.

The principal stress vectors will be plotted.
The von Mises stress contours for averaged stress values will be displayed.
Peak values of von Mises stress will be marked.

A graph will be produced showing the variation of stress along a slice section
through the handle of the spanner.

oooo
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Selecting the results to be viewed

Analysis loadcase results are present in the 2 @1 [Ele &2 [Dalfu Er
T.ree_vilew inside the _Analysus 1 entry as 5 &3 spanner.md
signified by the results bitmap w%. =23 Structural analyses
=-%= Analysis 1
[:l Gazometric
#-[_] Material
=7 1:Loadcase 1
Cl Supports
[:l Loading
----- W, Model properties

Deformed mesh plot

To plot a deformed mesh the Geometry and Attribute layers will be hidden, the Mesh
layer will be turned on, and the Deformed mesh layer will be added to the [= Treeview.

e Click the right-hand mouse button on the Geometry entry in the Treeview
and select the On/Off option. The geometry will be hidden from the display.

e Repeat to turn off the display of the Attributes layer.
e Repeat to turn on the Mesh layer.

e Double click on the Mesh layer in the Treeview to display the mesh layer
properties.
The mesh layer is to be plotted in green. Pen

Sek... | Sek...

Sek... | Sek...

e Select L= = and a dialog
will appear showing the range of pens
and colours in use.

Set... | Set...

Set... | Set...

| Set...

The mesh is currently drawn in a solid grey line
style and is shown by the button with dashed
outline.

Set... | Set...

Set...

| Set...

Set...l 7' Sek...

|
|
|
|
7' Set...
|
|
|
|
|

__________E

o Select the Green line pen. set... | | set...

e Click OK to redraw the mesh in the new Defaults | Clos= | Help
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colour.

Double click on the Deformed mesh layer in the Treeview to display the
deformed mesh layer properties.

Click the OK button
to select the defaults
and display  the
deformed mesh.

ey

I

Principal stress vector plots

Principal stresses can be plotted as vectors with different colours being used to signify
tension and compression.

The mesh layer is no longer required and it will now be hidden.

o Click the right-hand mouse button on the Mesh entry in the Treeview and

select the On/Off option.

Click the right-hand mouse button in a blank part of the view window and select
the Vectors option to add the vectors layer to the 5= Treeview.

The vector properties dialog will be displayed.

Select  Stress  vector
results of  Principal
stresses from the entity
drop down list.

Click the OK button to
display the wvector plot

with  tension  vectors
shown in red and
compression vectors
shown in blue.

Properties

Vector Flot I'u'ector Display I Scale

Entity

Type IPrincipaI

ﬂ

Location IA\reraged nodal

Transform SE_I I MNone

oK Cancel

Apply Help
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Viewing the Results

EE b

Creating new view windows

As an alternative to hiding, adding or removing layers from the Treeview for each
type of results to be displayed in a single view window, multiple view windows can be
defined. New views can be created using default settings, or existing views can be
saved before being applied to new views.

This creates a new view window with default view layers of Mesh, Geometry, and
Attributes. In the = Treeview, a new folder for spanner.mdl Window 2 will appear.

e In the Window 2 folder in the [=* Treeview, turn-off the Geometry, Attributes
and Deformed mesh layers

o Inthe!H Treeview, Loadcase 1 will be set active by default.

Using page layout mode

The model was created using a Working Mode view which allows a model of any size
to be created. Results could be viewed using this mode of operation, but in order to
allow additional information to be added without obscuring the model, Page Layout
Mode can be used instead.

The view window will resize to show the model view fitted on a piece of paper.

25



Linear Elastic Analysis of a Spanner

e Ensure that the Landscape [&H3Eails EHE
option is selected and that left,
right, top and bottom page
Margins of 60, 10, 10, 10
respectively are set.
e Click the OK button.
—Paper
Size: |A4 j
Source: I Auta Select j
r— Orientation I arging [millimeters)
 Portrait Left: IED Bight: |1D
& | andscape Top: |1D Bottom: |1D
Help | Cancel | Erinter... |

Von Mises stress contour plot

Contours of von Mises Stress (Equivalent Stress) may be plotted as lines or as colour-
filled contour ranges. To display stress contours the contour layer needs to be added to

the Treeview.

With no features selected, click the right-hand mouse button in a blank part of

the active window and select the Contours option to add the contours layer to

the Treeview.

The contour plot properties dialog will be displayed.

Ensure that Stress contour results
are selected from the Entity drop
down list, equivalent stresses SE
from the Component list, and
Averaged nodal are selected from
the Display list.

On the same dialog select the
Contour Display tab and ensure
that the Contour key button is
selected.

the contour key.

Properties E

Contour Results |Conbour Display I Contour Range I Seed Colours |

Entity Stress
Component |SE hd
Display Averaged nodal -

Transform ~ Set... || None

™ Display. on slice(s)
= Brawin slice local direction

Close | Cancel | Apply | Help |

Click the OK button to display the contour plot of equivalent stress along with
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Re-ordering layers in the Treeview

The order of the layers in the

Treeview governs the
order in which the layers are
displayed.

To see the mesh layer on top
of the contours the mesh
layer must be moved down

the Treeview list to a
position after the contour layer.

In the Treeview select the Mesh layer within Window 2, and drag and drop
the Mesh layer name on top of the contour layer name. The mesh layer name will
then follow the contour name and the mesh itself will then be displayed on top of
the contour layer.

Note. This ordering of layer names can also be done using the right-hand mouse
button and selecting the Move Down option from the context menu presented.

Moving the contour key and setting significant figures

press the Details button next to the ¥ |1c.— o | From bottom of paper
Contour key option. ¥ From top of paper
e Set the X position to 125mm From * Significant figures I—_,4 n
left of paper, and the Y position to " Decimal places =l
10mm From top of paper. LES
v Show loadcase ID
e Limit the Significant figures to 4 [¥ Show maximum value
and press OK to return to the [ Show minimum value
contour properties dialog.
— Appearance
e Press OK to save changes and see I™ Draw outiines around colours
the contour key position centrally ¥ Draw blue uppermost
near the top of the page. ¢ Draw red uppermost
Note. The contour key can also be moved ok | _ cond il

(more easily) graphically by selecting any

in the B Treeview double-click
C_OI’I'[OUI’S to open the properties —Position
dlalog. % From left of paper

¥ | 125 mm
{~ From right of paper

Select the Contour Display tab and

text or contour key colouring and dragging the key to a new position.
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[save View

Marking peak values

e With no features selected click the right-hand mouse button in a blank part of the
view window and select the Values option to add the values layer to the

Treeview.

The values properties dialog will be displayed.

e Ensure Stress contour results

from the Entity drop down list, valueresuks Valuesbisplay |
equivalent stresses SE from the ™' show values of selection
Component list, and Averaged = e e
R . v Yalues I Minima
nodal from the Location list are . _ _
* Sigrificant figures |:'
Selected " Decimal places =
¥ Show trailing zeros

e On the same dialog, select the | sy |

! i Failure details.. . |

Values Display tab and set pon #[ T =] [ choose pen.. ||

Maxima values to display the

I Deform

Font angle

ID.D @

top 1% of results. (This will ok | coneel |

Apply

| Help |

show the peak stress value)

e Click the OK button to add the peak values to the contour plot.

El Use the Zoom in button
to enlarge the view of the
spanner to check the number
obtained.

* | Press the Resize button
to fit the model to the full
view window.

Saving view windows

View layers and settings defined for a view can be saved for use with other view

windows and for use within reports.

e Accept the default settings presented and press the OK button to create a Saved

view entry- “View 1" in the Utilities & treeview.

To update a view with the settings from a saved view:

e Create a New Window using the Window > New Window main menu item.
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e Click on the Utilities & treeview and drag and drop the Saved view entry
for Viewl onto the newly created view window. This updates the newly created
view to show those layers and settings saved with View 1.

Note. It is very useful to name a saved view with a name that reflects the contents of
/ the view. For example, saved view names of ‘Contours of SE’, or ‘Maximum
displacement, or ‘Isometric view’ might be used, when relevant.

Creating a slice section of results

Section slicing of the model to create graphs of results is to be done with the model
lying orthogonal to the screen.

. @I Press the Home button to ensure that the model is viewed correctly.

| utiliies e Ensure the Snap to grid button is [ESELARGLTEDY
|Graph Through 2D... selected and a grid size of 10 is S B
specified. I Sraptogrid  Gridsize |10 =
e Click the OK button. [uct] _ fo200

I Generate new annotation line

1 By selected line

| |

Project ine  |Mormal ko screen ﬂ
) By selected surface

| I
1 it Incation of existing araph

| I

Ok I Cancel Help

e Click and drag the
cursor as shown (at the
X=40 location) to
define a section slice
through the handle of
the spanner where it
joins the jaws.

- Click here -

- Drag to here- -
The loadcase and extent of
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the slice must now be defined:

e Ensure that Loadcase 1 and an extent of Visible model are selected, and Click
the Next button.

This leads directly on to creating a graph using the graph wizard:

Selecting the slice data results to be plotted

In this example a graph is to be plotted of the variation in stress through the specified
section of the spanner. The X axis results of distance through the spanner have been
defined by the section slice. The Y axis results now need to be specified.

e On the Slice data dialog, ensure Eidu
Stress - contour results from the ¢ Resuitant effects from 20 model
Entity drOp down |ISt, and &+ Results component (".l?esultant effects from sli:e_I
equivalent stresses SE from the E”“:OJH
Component list are selected. Tarsform set[[Nore

e Click the Next button to define
the Y axis results Caleulate distance a5 angler

@[
ArC centre v |o.0
7 |0.0 LI

width for corridor averaging | 0.0
<Back [ mext> | cancal | Hep |

Title information for the graph is now to be added:
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Enter the graph title
as Stress at neck
section

Enter the X axis
label as Distance
along section

Enter the Y axis
label as Equivalent
Stress (N/mmz2)

Deselect the Show
symbols button.

Click the Finish
button to display the
graph in a new

window and show

Display Graph

= =

r~ Display

Title I Stress at neck section

Distance along section

¥ Show grid

v Corner labels

Equivalent Stress (Mfmmz)

[~ show symbals
v aAuto-update

Include existing graphs

Mame

=

|

Graphl

% scale
& aukomatic € Manual

mirn Ig,n max Il.D

™ Use logarithmic scale

Sicale Fackar IT
Fscale
& aukomatic € Manual
min IF maz IT

[ Use logarithmic scale

Scale Fackar I 1.0

W savein treeview W Display now

< Back I Finish I

Cancel Help

the values used in an adjacent table.

Spanner

Stress at neck section

Note. If the graph title or axes labels are left unspecified Modeller will use default

names.
Coordinates SE - |~ |
[40.60.0) to | 1:Loadcase
(40.-60.0)(1) 12
1 oo 17.3387
2 2537143 129571
] £.62078 13.2686
4 20,3202 149174
5 34.0339 16,5843
E 376892 21.8758 —_
Il Angete . 30028 I
£
£
=
@
o
2
i
€
5
"
=
El
=
w
ZI] - lspanner. mdl

Distance along section
—SE - 1:Loadcase 1(2) / Coordinates (40,60,0) to (40 ,-60,00(1)

E Close the graph window, and return the view window.

Units: Mmmts,C

Note. The properties of the graph may be modified by clicking on the graph with the
right-hand mouse button and selecting the Edit Graph Properties option.
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il To exit from the Graph Through 2D option click the Select Any cursor button.
The grid will be removed.

This completes the example.
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